
 

 

 

 

 

 

 

 

 

 

Primeiros passos com 

GeneXus™ 
Crie sua primeira aplicação sem saber codificar. 
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INTRODUÇÃO 

GeneXus é um conjunto de desenvolvimento Low-Code que permite a geração rápida de 

aplicativos de software em múltiplas linguagens e plataformas. GeneXus oferece diversas 

vantagens: é fácil de aprender, altamente produtivo, multiplataforma e preparado para o futuro, de 

forma a proteger seus ativos digitais e simplificar a adoção de novas tecnologias. 

Por exemplo, GeneXus gera aplicativos para a Web e/ou dispositivos móveis e inteligentes (desde 

um relógio de pulso, um telefone celular, um tablet ou uma TV), para a plataforma de destino 

selecionada pelo desenvolvedor (determinada linguagem, banco de dados, ambiente, plataforma, 

com design web responsivo, etc.). 

Este documento é um guia para iniciantes desenvolverem aplicativos com GeneXus. 

 

COMEÇAR A UTILIZAR GENEXUS 

Ao abrir GeneXus, você verá uma interface semelhante à seguinte conhecida como IDE 

(Ambiente de desenvolvimento integrado). Essa interface é fácil de usar e pode ser parametrizada 

por cada desenvolvedor. 

Consiste em diferentes janelas:
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1. Janela principal (Home page): exibe dinamicamente informações técnicas sobre a ferramenta e a 

Comunidade GeneXus (notícias e soluções publicadas por outros desenvolvedores). Ele também 

mostra os projetos que foram abertos recentemente e oferece a possibilidade de criar um novo 

projeto. 

2. KB Explorer: mostra objetos e configurações do projeto aberto atualmente. 

3. Barra de ferramentas: mostra uma interface fácil de usar para as funções mais usadas em 

GeneXus. 

4. Janela de Propriedades: mostra as propriedades associadas ao contexto em que o 

desenvolvedor está posicionado (como um objeto selecionado, atributo, variável, controle, etc.). 

5. Saída: mostra a saída das ações executadas. 

 

CRIAR UMA NOVA APLICAÇÃO COM GENEXUS 

 

Para começar a desenvolver uma nova aplicação com GeneXus, você deve criar uma nova Base de 

Conhecimento (uma Base de Conhecimento é um projeto GeneXus). 

Ao selecionar File > New > Knowledge Base na barra de ferramentas, a seguinte caixa de diálogo 

será exibida: 

 

O aplicativo do exemplo que será definido em todo este documento é um aplicativo real, mas 

simplificado, para uma farmácia. Portanto, faz sentido que a Base de Conhecimento seja chamada 

"Farmácia" (ou "PharmacySystem", entre outras opções). Em seguida, você deve inserir o caminho 

onde deseja criar essa Base de Conhecimento. 
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O próximo passo é selecionar uma das linguagens de programação disponíveis na caixa de 

combinação Prototyping Environment. GeneXus usará a linguagem selecionada para gerar o 

aplicativo, assim como os programas necessários para criar e manter o banco de dados. O idioma 

selecionado na imagem acima é .NET Core. Mais tarde, você deve inserir os detalhes do banco de 

dados. 

 

A caixa de combinação Linguagem permite selecionar o idioma em que você deseja que GeneXus 

gere os títulos de botões automáticos, etiquetas, mensagens para usuários, etc. O idioma padrão é 

o inglês. 

 

Ao pressionar o botão Criar, GeneXus inicia o processo de criação da Base de Conhecimento. 

 

DEFINIR OS PRIMEIROS OBJETOS 

Depois de criar uma nova base de conhecimento, você deve descrever as exibições dos usuários. 

Para isso, você precisa identificar objetos na vida real (recomendamos atenção para os 

substantivos que os usuários mencionam em suas descrições, como produtos, faturas, clientes, 

etc.) e começar a defini-los usando objetos GeneXus. 

Os desenvolvedores GeneXus não trabalham em tarefas de baixo nível, como definir tabelas, 

normalizar, projetar programas, programação e afins. Em vez disso, seu trabalho é uma atividade 

de nível superior que envolve descrever a realidade dos usuários. Depois disso, GeneXus analisa os 

objetos definidos e passa a projetar os programas de banco de dados e aplicativos para a 

plataforma selecionada de forma totalmente automática. 

Considere o caso em que a farmácia que solicita o pedido deseja registrar os produtos que tem 

para venda. 

Para descrever cada objeto da vida real identificado, você deve criar um objeto GeneXus do tipo 

Transação (não está relacionado a Transações do banco de dados). Então, vamos ver como criar 

um objeto Transação para descrever os produtos. 

Ao selecionar File > New > Object  na barra de ferramentas, o seguinte diálogo será exibido, 

permitindo que você selecione o tipo de objeto que deseja criar e insira um nome para ele. Você 

tem que selecionar o tipo de Transação e chamá-lo: Produto. 
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Ao clicar no botão Criar, a Transação do Produto é criada e se mantém aberta para começar a 

definir sua estrutura: 

 

Cada Transação tem algumas seções que serão explicadas gradualmente. Especificamente, a 

estrutura de uma Transação permite definir os atributos ou campos que descrevem um objeto da 

vida real. 

Suponha que você tenha sido informado na farmácia que, para cada produto, você precisa manter 

um registro do seu código, nome, preço de venda, estoque e tipo (remédio, cosmético, etc.). 

Portanto, esses dados que devem ser registrados para cada produto, coincidem com os atributos 

que devem ser criados para essa Transação. 

Observe que, na imagem acima, a primeira linha na estrutura da Transação é criada pronta para 

inserir o primeiro atributo. Além disso, observe que um ícone com a imagem de uma  
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chave está associado a essa linha. A razão é que cada Transação, um atributo ou conjunto de 

atributos deve ser configurado com uma função de identificador ou chave. 

O conceito de atributo identificador ou atributo chave tem como objetivo identificar de forma 

única cada produto (ou qualquer objeto). Em outras palavras, os usuários não poderão inserir dois 

produtos com o mesmo valor de identificador. Claramente, o atributo chave da Transação do 

Produto é o código do produto. Então, vamos ver como definir isso. 

Ao pressionar a tecla ponto no teclado, GeneXus mostrará automaticamente o nome da Transação 

como um prefixo no nome do atributo: 

 

e você só tem que escrever código após o prefixo do Produto: 

 

Em seguida, pressionando a tecla Tab, você pode escolher o tipo de dados que serão armazenados 

para esse atributo. O tipo de dados padrão é numérico de 4 dígitos sem decimais. No entanto, a 

farmácia solicitou que o código do produto sempre tivesse um valor numérico de até 10 dígitos, 

portanto, ele deve mudar seu tamanho para 10:  
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Quando você pressiona Enter, uma nova linha é aberta, onde você pode começar a definir o 

segundo atributo: 

 

Novamente, você deve pressionar a tecla de ponto no teclado e completar o nome do atributo com 

Nome, ou seja, ProductName (do tipo de Caractere e comprimento de 50): 

 

 

Agora você deve adicionar o atributo ProductPrice (do tipo numérico, com 9 dígitos e 2 casas 

decimais): 
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Como você provavelmente precisará criar mais atributos para definir preços ou quantidades (isto é, 

quando a farmácia compra ou vende produtos), pode ser uma boa ideia criar um tipo de definição 

genérica para todos os preços. Para fazer isso, na coluna Tipo, basta digitar: "Price =", antes do tipo 

que você selecionou: 

 

Em seguida, pressione Enter e você verá que o atributo ProductPrice foi definido como um tipo 

Preço (Price): 

 

A definição de Preço com tipo numérico (9 dígitos com 2 casas decimais) é chamada de Domínio. 
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Os domínios permitem fazer definições genéricas. Uma das vantagens que os domínios fornecem é 

que, se mais tarde você precisar que os preços sejam numéricos de duração diferente, só deverá 

alterar a definição de domínio para atualizar todos os atributos baseados nesse domínio em uma 

etapa só. 

Para ver os domínios criados na Base de Conhecimento, selecione View > Domains na Barra de 

Ferramentas: 

 

 

Como é mostrado na imagem, GeneXus cria alguns domínios automaticamente. Quando você clica 

em um determinado domínio, a janela de propriedades é atualizada com suas propriedades. 

Tenha em mente que, além de configurar o tipo de dados para um domínio, você também pode 

definir outras propriedades interessantes. 
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A janela de Propriedades será atualizada toda vez que você selecionar outro atributo, domínio, 

objeto, etc., com as correspondentes propriedades disponíveis para configuração em cada caso. Se 

não estiver visível, você pode pressionar F4 para abri-lo. 

Vamos voltar para a Transação do Produto, onde o atributo a seguir que você deve definir é o 

ProductStock do tipo numérico e o tamanho 4: 

 

Agora é necessário registrar o tipo de produto. Você poderia criar um atributo chamado 

ProductType como Character (50) ... 

 

 

Mas o que acontece se os usuários quiserem inserir dois produtos do mesmo tipo? Eles teriam que 

digitar o mesmo nome de tipo duas vezes, tomando o cuidado de escrever exatamente o mesmo! 



 

12 

 

Mais tarde, eles podem precisar procurar por todos os produtos de um certo tipo e, para obtê-los, o 

tipo deve ter sido escrito exatamente da mesma maneira. 

 

Parece mais razoável inserir o tipo apenas uma vez, em um local e, posteriormente, para cada 

produto, para fazer referência ao tipo de produto correspondente. Portanto, vamos remover o 

atributo ProductType da estrutura e salvar a Transação do Produto, conforme mostrado: 

 

 

GeneXus criou automaticamente um formulário web de acordó (Web Layout) com a estrutura 

definida. Este formulário permitirá que os usuários adicionem, atualizem e excluam produtos em 

tempo de execução: 
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Agora, vamos criar outra Transação para registrar os tipos de produtos e, em seguida, atribuir um 

tipo de produto a cada produto: 

 



 

14 

 

 

Vamos manter o código e o nome de cada tipo de produto:  

 

 

Lembre-se da nossa recomendação de pressionar a tecla ponto no teclado ao definir atributos, 

para que GeneXus escreva automaticamente o nome da Transação como um prefixo, e tenha 

apenas que completar o final dos nomes dos atributos. 

 

Nomear atributos com o nome da Transação como um prefixo não apenas permite definir 

atributos com mais facilidade e rapidez, mas também é uma convenção da comunidade 

GeneXus para facilitar a compreensão ao ler um nome de atributo onde quer que ele esteja, 

para saber o que objeto está sendo descrito. 

 

 

Vamos ver as propriedades do atributo ProductTypeCode: 
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Observe a propriedade Autonumber. Está configurada com o valor False por padrão e, quando 

alterado para True, todos os novos tipos de produtos inseridos pelo usuário final serão numerados 

automaticamente consecutivamente. Portanto, defina a propriedade Autonumber como True para 

este atributo de identificador e salve a Transação ProductType. 

Como explicado acima, cada Transação possui um formulário web (Web Layout) projetado 

automaticamente por GeneXus de acordo com sua estrutura. A imagem a seguir mostra o 

formulário da Web ProductType: 
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Agora, atribua um tipo de produto a cada produto. Em seguida, volte para a Transação do Produto 

e inicie em uma nova linha de sua estrutura digitando a letra "P", para mostrar a lista de atributos 

existentes na Base de Conhecimento que começa com essa letra: 

 

 

Quando você seleciona ProductTypeCode, sua definição completa é exibida. 

Nesta Transação também inclui o atributo ProductTypeName, porque quando os usuários 

executam essa Transação e selecionam um código de tipo de produto, eles querem ver o nome 

correspondente do tipo de produto no formulário. Vamos nos concentrar nesses dois atributos 

incluídos em mais de uma Transação: 

 

ProductTypeCode é o atributo identificador na Transação ProductType (mais especificamente, é a 

chave primária dessa Transação). Então, quando uma chave primária é incluída em outra Transação, 

GeneXus entende que ali o atributo tem o papel de chave estrangeira. 
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A inclusão de um atributo que é uma chave primária de uma Transação em outra Transação 

permite relacionar ambas as Transações 

 

 

GeneXus estabelece relações através de nomes de atributos, portanto, quando encontra atributos 

com o mesmo nome em Transações diferentes, supõe que referem ao mesmo conceito. 

 

O atributo ProductTypeName também está presente em ambas as Transações. No entanto, ele não 

está marcado como um identificador de nenhuma das Transações definidas. Portanto, GeneXus 

assumirá como um atributo secundário. GeneXus incluirá ProductTypeName na tabela física 

ProductType que será criada no banco de dados e não na tabela física de Produto. 

 

O conceito de Transação e o conceito de tabela física não são os mesmos. Lembre-se que a 

Transação é o objeto GeneXus que você cria na Base de Conhecimento para representar um objeto 

da realidade. Quando se considera sua estrutura e as demais estruturas de Transação definidas na 

Base de Conhecimento (e também levando em conta algumas propriedades), GeneXus 

determinará as tabelas físicas que devem ser criadas no banco de dados, bem como os atributos 

que devem ser armazenados em cada tabela. 

 

 

Em tempo de execução, ao executar o formulário da Transação do Produto, o usuário deve inserir o 

atributo ProductTypeCode (que é um atributo de chave estrangeira), um valor que foi anteriormente 

registrado por meio da Transação ProductType. Caso contrário, um erro será exibido. Ao inserir um 

ProductTypeCode válido, seu valor ProductTypeName será obtido e exibido na tela. 
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GERAR E EXECUTAR A A PLICAÇÃO PELA PRIMEI RA VEZ 

Se você deseja gerar e executar o aplicativo pela primeira vez, basta pressionar F5 e a seguinte 

caixa de diálogo será exibida: 

 

 

GeneXus oferece a possibilidade de criar um protótipo da aplicação localmente ou na nuvem. 

Existe uma propriedade para definir isso e, por padrão, a propriedade é configurada para 

prototipar localmente. Em seguida, você deve inserir o nome desejado para o banco de dados de 

seu aplicativo e o nome do servidor de banco de dados que você instalou:
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Clicando em Finish, GeneXus avaliará o impacto causado pelas novas definições na Base de 

Conhecimento e mostrará um relatório com o nome Análise de Impacto: 

 

 

Este relatório mostra quais alterações estruturais devem ser feitas no banco de dados. 

Quando você ler o relatório, verá que, nesse caso, o título principal informa que “As tabelas do 

banco de dados serão criadas”. 

 

Clicando em cada tabela (ProductType e Product na janela da esquerda), você verá na janela à 

direita os atributos que serão incluídos neles: 
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Observe que, conforme explicado, o atributo ProductTypeName não está incluído na tabela física 

Product que será criado, mesmo que tenha sido incluído na estrutura da Transação Product (a fim 

de mostrá-lo em seu formulário). 

 

Se você concorda com a Análise de Impacto, você pode clicar no botão Create, e GeneXus 

começará a criar os programas necessários para criar o banco de dados (ainda não existente), bem 

como as tabelas com suas estruturas nesse banco de dados. A seguir, GeneXus executa esses 

programas e depois de criar o banco de dados e as tabelas, irá gerar todas as linhas de código 
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necessárias, na linguagem de programação selecionada, para obter a aplicação que permitirá aos 

usuários inserir, atualizar e eliminar tipos de produtos e productos. 

 

Em seguida, você será informado se o resultado foi bem sucedido ou se houve um erro ou aviso e 

você verá o aplicativo em execução: 

 

 

 

 

 

 

 

O navegador da Web é aberto por padrão para exibir uma página simples que oferece uma maneira 

rápida de executar os objetos definidos. 

 

Esta página simples, chamada de Developer Menu  (Menu do Desenvolvedor), é para os 

desenvolvedores, como indica seu nome. Obviamente, não é o que os usuários verão na tela. 

Clique com o botão direito do mouse no link ProductType e abra-o em uma nova guia: 
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A página mostrada acima permite ao usuário adicionar, atualizar e excluir tipos de produtos. Digite 

o primeiro tipo de produto. 

Visto que o atributo ProductTypeCode tem a propriedade Autonumber configurada em True, os 

usuários não precisarão inserir um valor para o identificador porque ele será numerado 

automaticamente. Portanto, insira o nome do tipo de produto: 

 

 

Depois de inserir o nome do tipo de produto e clicar no botão Confirmar, aparecerá uma 

mensagem informando que os dados foram adicionados corretamente. O formulário estará vazio e 

pronto para entrar em outro tipo de produto: 
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Digite o segundo tipo de produto: 

 

Clique no botão Confirmar e então você pode examinar os dados para confirmar que eles estão 

numerados: 
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Agora, execute a Transação do Produto. Para fazer isso, selecione a guia do navegador na qual a 

página Menu do Desenvolvedor é exibida e, em seguida, execute a Transação do Produto: 
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Tente adicionar o primeiro produto: 

 

Você deve indicar o tipo de produto. Se você se lembrar do código do tipo de produto, poderá 

inseri-lo. Outra opção é selecioná-lo em uma lista clicando na seta azul. 
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Agora, tente excluir um tipo de produto: 

 

Uma mensagem informa que a exclusão não pode ser realizada porque há dados relacionados no 

Produto (o medicamento para dor muscular STAR é um produto que pertence a este tipo de 

produto). 
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A APLICAÇÃO CRESCE 

 

Você provavelmente já viu tudo o que GeneXus gerou automaticamente a partir dos dois objetos 

que você definiu. 

 

Agora, suponha que na farmácia eles digam que, para cada produto, eles querem registrar uma 

imagem. 

 

Para isso, volte ao GeneXus e, na Transação do Produto, basta digitar um atributo chamado 

ProductPhoto: 

 

O tipo de imagem permite armazenar imagens. 

 

O formulário da web é atualizado automaticamente, incluindo o atributo ProductPhoto. 

 

Pressione F5 e GeneXus avaliará o impacto causado pelas novas definições na Base de 

Conhecimento. Em seguida, o relatório de Análise de Impacto será exibido (Impact Analysis 

Report): 
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Lembre-se de que o Relatório de Análise de Impacto indica as mudanças estruturais necessárias no 

banco de dados. 

 

 

 

Quando você ler o relatório, você verá que o título principal, neste caso, informa que você precisa 

de uma reorganização do banco de dados. O termo "Reorganizar" implica a tarefa de fazer 

alterações no banco de dados. Nesse caso específico, o relatório indica que a tabela Product deve 

ser atualizada. 

 

Ao clicar no botão Reorganizar, GeneXus irá criar e executar os programas que farão alterações no 

banco de dados. Em seguida, ele gerará os programas necessários que correspondem ao 

aplicativo. 

Observe que você terá imediatamente o aplicativo em execução novamente no navegador da Web, 

com a nova definição incluída: 
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Se você se lembrar do código do produto, poderá inseri-lo. Outra opção é selecioná-lo em uma lista 

clicando no botão SELECIONAR. De lá, você pode recuperar a "medicação para dor muscular STAR" 

e enviar sua foto: 
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INCLUIR REGRAS DE NEGÓCIOS 

 

Além de todos os controles automáticos incluídos por GeneXus nos aplicativos que gera, algumas 

vezes os usuários solicitam alguns controles específicos. Em Transações, as regras que devem ser 

atendidas, ou os controles que devem ser executados, são definidos na seção Rules. 

 

Se, por exemplo, um requisito é que você não pode salvar produtos sem nome, GeneXus oferece 

uma regra chamada Error que lhe permitirá evitar isso: 

 

 

 

Pressione F5 e GeneXus salvará e avaliará as novas definições incluídas na Base de Conhecimento. 

Nesse caso, você deduzirá que não é necessário modificar o banco de dados, portanto, ele não 

mostrará um Relatório de Análise de Impacto. GeneXus irá gerar o código necessário e depois 

executar o aplicativo atualizado com as novas definições. 

 

Execute a Transação Product. Observe que, se o nome do produto for deixado em branco, a regra 

definida será executada: 
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Há outra regra cuja sintaxe é muito semelhante à regra de erro. Se chama Msg e a única diferença 

entre eles é que, se a condição for atendida, nesse caso, a mensagem será exibida como um aviso 

ou advertência e o usuário poderá continuar trabalhando. 

Se, por exemplo, você quiser informar que o preço do produto foi deixado em branco sem forçar o 

usuário a inseri-lo, poderá adicionar a seguinte regra na Transação Product: 

 

 

 

Este conjunto de regras poderia ser escrito em qualquer outra ordem e o resultado em tempo de 

execução seria exatamente o mesmo, porque GeneXus decide quando cada uma das regras 

definidas deve ser disparada (quando o usuário abandona cada campo, etc.). 

 

É claro que existem mais regras disponíveis em GeneXus para definir diferentes tipos de validações 

e ações. 

 

Cada Transação deve ter suas próprias regras de comportamento definidas. 
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DEFINIR CÁLCULOS: FÓRMULAS 

 

Geralmente, é necessário que os aplicativos executem cálculos que envolvam os valores de 

determinados atributos, constantes e / ou funções específicas. Para todos esses casos, o GeneXus 

oferece Fórmulas. 

 

Existem diferentes maneiras possíveis de definir fórmulas. 

 

Vamos começar aprendendo o que é uma Global Formula. Uma fórmula global é um cálculo que o 

desenvolvedor define juntamente com um atributo. Observe que as estruturas de Transação 

contêm uma coluna chamada Fórmula: 

 

 

 

Quando um cálculo é definido nessa coluna para um atributo, isso significa que o atributo é virtual. 

Em outras palavras, ele não será fisicamente criado como um campo em uma tabela porque o 

valor do atributo será obtido toda vez que for necessário, fazendo o cálculo. 

 

Vamos ver isso com um exemplo. Suponha que a farmácia precise saber, em todos os momentos, 

quantos produtos registrados são de cada tipo de produto. Em seguida, defina um novo atributo 

na Transação ProductType para defini-lo como uma fórmula global: 
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Agora, defina o cálculo associado ao atributo ProductTypeProductQuantity. 

GeneXus oferece uma fórmula chamada Count para calcular o que a farmácia precisa (existem 

muitos outros, como Sum, Average, etc.). 

 

O atributo que é referenciado dentro dos parênteses da fórmula fornece ao GeneXus as 

informações da tabela a ser navegada para fazer o cálculo (na definição anterior, GeneXus sabe que 

tem que contar na tabela Product). Então, se GeneXus detectar um relacionamento entre a tabela 

que irá navegar (Product) e o contexto em que o atributo da fórmula (ProductType) está definido, 

ele só considerará os registros relacionados para o cálculo. Neste exemplo, ProductTypeId está 

presente em ambos os contextos: onde a fórmula está definida e na tabela que deve ser navegada 

para calcular a fórmula. Portanto, apenas os produtos de cada tipo de produto são contados, em 

vez de todos os produtos registrados na tabela. Se nenhuma relação for encontrada, GeneXus irá 

calcular todos os registros da tabela. 

 

Pressione F5. Você pode ver que nenhuma alteração física será feita no banco de dados. O GeneXus 

só irá gerar alguns programas e o Menu do Desenvolvedor será executado novamente: 

 

Execute a Transação ProductType para ver, para cada tipo de produto, como a quantidade do 

produto é sempre calculada no momento: 
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Você pode adicionar mais produtos para verificar, para cada tipo de produto, como a quantidade 

do produto é sempre calculada no momento. 
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USO DE PADRÕES (PARA  WEB E PARA DISPOSITIVOS MÓVEIS) 

Os padrões permitem que você aprimore ainda mais seus aplicativos automaticamente. 

Aplicar um padrão é realmente fácil, e imediatamente GeneXus cria objetos, códigos e 

configurações para fornecer um comportamento interessante sem a necessidade de programá-los. 

 

Observe a seção Padrões de uma Transação. Por exemplo, na Transação ProductType, selecione a 

seção Patterns: 

 

Tenha em mente que existem duas guias disponíveis e cada uma oferece um padrão diferente que 

será aplicado à mesma Transação. 

 

Primeiro, selecione a guia Work With for Web para ver como é fácil aplicar um padrão e quão 

rapidamente resultados interessantes são obtidos. 

 

Basta clicar na caixa de seleção Apply this pattern on save  e salvar ( ): 

 

 
 

Em seguida, se você procurar a Transação ProductType no KB Explorer, você pode ver que existem 

vários objetos debaixo da Transação: 
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Eles foram criados por GeneXus quando o padrão Work With for Web foi aplicado. 

Agora pressione F5 para ver os resultados em tempo de execução:

 

Veja o último link que é mostrado. É oferecido "trabalhar com tipos de produtos" e de lá a 

Transação ProductType será chamada. Clique nesse link. 
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Você pode ver que uma página é aberta mostrando todos os tipos de produtos armazenados. Esta 

página permite que os usuários trabalhem com os tipos de produtos com uma ampla variedade de 

recursos. 

 

Por exemplo, clique em ATUALIZAR para a primeira linha: 
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Você pode ver que a Transação ProductType é aberta para editar os detalhes do tipo de produto 

nessa linha. Altere o nome do tipo e confirme: 
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Após a edição e confirmação, o aplicativo retorna à página Work With Product Types (Trabalhar com 

tipos de produtos): 

 

O link DELETE oferece aos usuários para eliminar o tipo de produto na linha. 

 

Além disso, o botão INSERT localizado fora da grade permite que os usuários adicionem novos 

tipos de produtos. 

 

Quando você clica nesse botão, a Transação é abertaProductType, pronto para adicionar um novo 

tipo de produto. Pressione-o para inserir um novo tipo de produto (lembre-se de que, nesse caso, 

só é necessário inserir o nome do tipo de produto porque você configurou a propriedade 

Autonumber do atributo-chave com valor True): 

 

Mais uma vez, após a inserção, o aplicativo retorna à página Work With Product Types: 
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Agora observe que cada nome de tipo de produto possui um link. Clique no tipo de produto: 

Medicamentos. 

 

 

Como você pode ver abaixo, todos os detalhes do tipo de produto selecionado são mostrados na 

primeira guia, e outra guia mostra a lista de produtos que pertencem a esse tipo de produto. 
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A guia Product  foi gerado automaticamente porque cada tipo de produto tem vários produtos 

relacionados. Se cada tipo de produto também tivesse vários dados relacionados de outro tipo, 

mais guias teriam sido geradas para mostrar cada lista de dados relacionados ao tipo de produto. 

 

Agora, volte para a página Work With Product Types, clicando no link correspondente na seção 

Recentes que aparece no canto superior esquerdo da página.  

 

Tenha em mente que é possível pesquisar por nome. Isso significa que, se, por exemplo, o usuário 

digitar "C", apenas os tipos de produtos que começam com essa letra serão exibidos.: 

 

Volte para GeneXus, até agora você só selecionou Apply this pattern on save na abaWork With for 

Web da Transação ProductType, e depois de salvar, você viu todas as funções que são geradas 

automaticamente. 

 

O que você pode não ter notado é essa árvore configurável: 
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Possui nós, sub-nós e elementos configuráveis, para que seja possível personalizar os 

comportamentos a serem gerados (ou seja, alterar os critérios de pesquisa). 

 

Aplique também o padrão Work With for Web à Transação do Product. Como explicado 

anteriormente, basta abrir a Transação Product e em sua seção Patterns, você deve selecionar a 

guia Work With for Web; então você tem que marcar a opção Apply this pattern on save e salvar: 
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Pressione F5. GeneXus gera os programas necessários e executa o aplicativo com as alterações. 

Então, execute a página Work With Product: 

 

Você pode ver as mesmas funções de consulta que viu na página Work With Product Types: 
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Inserir um novo produto: 

 

 

 

Após a confirmação, o aplicativo retorna à páginaWork With Product: 
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Visto que é irrelevante mostrar o código do tipo de produto na grade, remova-o da árvore 

configurável que é considerada para gerar esse componente Work With for Web: 

 

 

Aperte F5 e GeneXus salvará o que foi feito, gerando apenas os programas necessários e 

executando o aplicativo com as alterações: 
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Adicione alguns produtos da mesma maneira consecutiva mostrada acima (pressionando o botão 

INSERT que chama a Transação Product). 

 

Abaixo está a caixa de diálogo Work With Products que lista todos os produtos que foram 

adicionados: 

  

 

 

Agora preste atenção na guia Work With for Smart Devices que é oferecido para cada Transação. 

Aplique-o à Transação ProductType: 
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Note que abaixo ao nó principal (ProductType), existe o nó List. Se você clicar nele, na janela à 

direita, você verá uma grade contendo o atributoProductTypeName. 

 

Ao contrário do padrão Work With for Web, neste caso, o desenho (Layout) já é mostrado em vez de 

uma lista de atributos que serão incluídos na grade abaixo do nó. 

 

Agora, olhe para o nó Detail, que permite ver os detalhes de uma determinada linha na lista. 

 

O nó Detail é composto de duas seções: General eProduct. 

Igual a funcionalidade implementada para o padrão Work With for Web, a seção General mostra 

todos os dados associados com o tipo de produto selecionado e a seção Product mostra dentro de 

uma faixa todos os productos que pertencem ao tipo de produto. 
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Depois de aplicar esse padrão e salvar, se você observar a Transação ProductType no KB Explorer, 

agora você pode ver um novo objeto chamado WorkWithDevicesProductType abaixo da Transação 

ProductType: 

 

Se você observar os dois objetos gerados na Transação ProductType, verá que 

WorkWithDevicesProductType não possui outros objetos abaixo (porque inclui seções diferentes 

para definir a implementação completa em seu interior). 

Por outro lado, WorkWithProductType, como você viu, é uma instância configurável; assim, você 

pode configurar e salvar esse objeto e GeneXus gera outros objetos abaxo dele para fornecer os 

comportamentos úteis que foram mencionados. 

Em breve, você verá o componente WorkWithDevicesProductType em ação. 

A proposta agora é criar um objeto Panel, para ser o primeiro objeto do aplicativo a ser executado. 

Ele mostrará uma imagem, de modo que, quando o usuário a tocar, seja executado o objeto 

WorkWithDevicesProductType. 

Como explicado acima, para criar um objeto, basta selecionar File > New > Object na barra de 

ferramentas. A próxima janela abre e você deve escolher a categoria Smart Devices, para mostrar os 

objetos que GeneXus oferece nesta categoria: 
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Depois de ter criado o Panel (que neste exemplo foi chamado PharmacyMenu), você deve 

configurar sua propriedade Main program = True, para que este objeto se torne um objeto 

executável independente do Developer Menu (isto é, é compilável e executável por si só). 
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Agora insira um controle de imagem em seu layout (design): 

 

 

Quando você seleciona Insert > Image a janela a seguir é exibida. Se a sua foto está armazenada em 

um arquivo, você deve pressionar o botão Import from file (Importar do arquivo). 
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Depois de importar a imagem para a Base de Conhecimento e inseri-la no Layout do Panel 

PharmacyMenu, seu design deve ficar assim: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Quando você clica duas vezes no controle de imagem, o evento associado é exibido por padrão: 

 

Dentro do evento Tap associado à imagem, o objeto WorkWithDevicesProductType deve ser 

chamado; mas esse objeto é composto de muitas partes (lembre-se ou observe seus nós 

novamente). Neste caso particular, você deve chamar o nó List do objeto, já que nosso objetivo é 

mostrar a lista com todos os tipos de produtos oferecidos pela farmácia. 

 

Para conseguir isso, depois de localizar o cursor dentro do evento, selecione Insert > Object. 

 

O seguinte diálogo é exibido: 
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Filtre como mostrado acima e selecione o objeto WorkWithDevicesProductType: 

 

 

O nome do objeto foi inserido, então agora vamos completar qual componente do objeto deve ser 

executado. 

 

Para entender o que você deve concluir na linha de código, verifique a árvore de nós que está 

dentro do objetoWorkWithDevicesProductType: 
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O objeto tem um nó principal, ProductType, e abaixo dele você pode encontrar os nós List e Detail, 

respectivamente. Para chamar o nó List, a sintaxe completa é: 

 

Agora tudo está definido e pronto para executar o aplicativo para dispositivos móveis e 

inteligentes. 

 

Visto que o objeto PharmacyMenu tem sua propriedade Main Program configurada como True, ele 

pode ser executado independentemente da KB Explorer, clicando com o botão direito do mouse 

no objeto e selecionando Run: 
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Você pode executar em seu computador com um emulador de dispositivos móveis e inteligentes 

que serão abertos ou diretamente no seu dispositivo inteligente se você os conectou ao 

computador no qual você está trabalhando: 

 

Quando você toca na imagem, a lista de tipos de produtos oferecidos pela farmácia é exibida: 
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Observe que o botão Inserir no canto superior direito pode ser facilmente excluído, pois esse 

aplicativo é para usuários finais e não queremos que eles possam inserir novos produtos; eles só 

devem poder ver os diferentes tipos de produtos, não editá-los. 

 

Ao clicar  em cada tipo de produto (por exemplo, "Cosméticos para adolescentes"), o Detalhe, junto 

com suas duas seções GENERAL e PRODUCT: 
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Obviamente, esta é apenas uma demonstração muito simples, uma vez que aplicações muito mais 

sofisticadas podem ser alcançadas. 
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O QUE ACONTECE SE VOCÊ QUER GERAR O QUE DEFINIU DENTRO DE OUTRA LINGUAGEM OU 

DE OUTRA BASE DE DADOS?   

 

Como mencionado acima, uma das grandes vantagens de GeneXus é que ele permite gerar o 

mesmo aplicativo para diferentes plataformas, gerar código em diferentes linguagens de 

programação e / ou armazenar os dados do aplicativo em diferentes bancos de dados. Toda esta 

informação é definida em um Environment. 

 

Um Environment permite que você configure e armazene todas as informações relacionadas a uma 

implementação específica de sua aplicação (os geradores que deseja usar para gerar o Back end de 

sua aplicação, os geradores que serão usados para gerar o Front end, as informações do banco de 

dados, etc.). 

 

Selecione a janela Preferences clicando na guia ao lado da guia KB Explorer:

 

Você pode ver que há apenas um Environment definido (Environment .NET Core). 

Ele foi criado automaticamente quando a Base de Conhecimento foi criada quando você escolheu 

.NET Core como a linguagem de geração. 

Em seguida, ele foi preenchido com mais informações quando você pressionou F5 pela primeira 

vez e indicou as informações sobre o banco de dados a ser criado e o servidor de banco de dados. 

Os subnós do Environment permitem configurar mais propriedades. 

 

É possível criar mais de um ambiente de execução para a mesma Base de Conhecimento. Por 

exemplo, é comum criar um ambiente para desenvolvimento no qual você se conecta a um banco 
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de dados com dados de teste e um ambiente para produção, em que define o servidor e o banco 

de dados que você usará para o sistema finalizado. 

 

Você também pode criar, na mesma Base de Conhecimento, um novo ambiente para gerar tudo 

para uma plataforma diferente (Por exemplo, gere o código em Java e use outro SGBD como 

Oracle, MySQL, PostgreSQL, DB2 ou outros. E para a geração do Front end você pode usar Apple ou 

Angular). 

 

Como se muestra en la siguiente imagen, para crear un nuevo Environment, debe hacer clic con el 

botón derecho del mouse sobre el nodo de su Environment, seleccionar New Environment y luego 

configurar las propiedades necesarias. 

 

Como mostrado na imagem a seguir, para criar um novo ambiente, você deve clicar com o botão 

direito do mouse no nó em seu Environment, selecionar New Environment e depois configurar as 

propriedades necessárias. 

 

Para escolher trabalhar com um ambiente ou outro, você deve clicar com o botão direito no 

Environment que deseja ativar e escolher Set as Default Environment. 

 

É possível identificar o Environment ativo pelo símbolo PLAY. 

 

Obtenha mais informaçõe sobre como criar um novo ambiente. 

  

 

https://wiki.genexus.com/commwiki/servlet/wiki?24702,Create+new+environment+dialog,
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O QUE MAIS OFERECE GENEXUS? 

 

- Acesso a bases de dados externas: 

o Você pode precisar acessar bancos de dados externos a partir de aplicativos GeneXus. Por 

exemplo, carregue dados de um banco de dados externo para as tabelas no banco de 

dados associadas à Base de Conhecimento para executar uma carga inicial. Em seguida, 

você pode não precisar ficar conectado a esse banco de dados externo, ou pode precisar se 

conectar e estar sempre conectado a uma determinada tabela ou tabelas de um ou mais 

bancos de dados externos (não apenas para lê-los, mas também para acessar e alterar os 

dados neles). GeneXus oferece um "processo de engenharia reversa" para conectar-se a 

tabelas de banco de dados externas, a fim de atender às necessidades descritas acima. 

 

- Suporte ao desenvolvimento colaborativo:  

o GeneXus Server oferece a opção de carregar uma Base de Conhecimento em um servidor. 

Em seguida, novos desenvolvedores podem criar uma cópia local da Base de 

Conhecimento no servidor, de qualquer localização geográfica, quando surgir a 

necessidade. Eles podem trabalhar (sempre localmente) e enviar suas alterações para o 

servidor. Claro, existe um mecanismo para resolução de conflitos. Esta solução oferece 

muitas vantagens, incluindo o controle de versão dos modelos na Base de Conhecimento. 

 

- Consumir e definir serviços da web: 

o É possível consumir serviços web desenvolvidos por terceiros a partir de uma aplicação 

GeneXus, bem como desenvolver seus próprios serviços web com GeneXus. 

 

- Definir atualizações massivas do banco de dados e definir livremente outros tipos de processos. 

 

- Definir painéis interativos e personalizados para aplicativos Web e aplicativos para dispositivos 

móveis e inteligentes. 

 

- Projetar e ajustar interfaces do usuário (UIs) 

o GeneXus oferece o poder de personalizar a interface do usuário e, por ser extremamente 

importante a experiência do usuário, oferece geradores específicos para aplicativos nativos, 

aplicativos com design web responsivo, web móvel, etc. Também oferece uma função Live 

Editing de edição ao vivo multiplataforma que simplifica o processo de projetar seu 

aplicativo e criar um protótipo ao vivo (Live Prototyping). 

 

 

 

 

http://wiki.genexus.com/commwiki/servlet/wiki?27805,Toc%3ALive+Editing
http://wiki.genexus.com/commwiki/servlet/wiki?27805,Toc%3ALive+Editing
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- Implementar seu aplicativo em produção em servidores locais ou provedores de serviços em 

nuvem 

o Ao clicar em um botão, você pode implementar sua aplicação em produção. 

 

- Documento dentro da Base de Conhecimento 

o GeneXus fornece um editor de Documentação no estilo do Wiki, para que você possa 

descrever facilmente o propósito da Base de Conhecimento (em um objeto do tipo 

Documentation, chamado Main, que é criado automaticamente em qualquer Base de 

Conhecimento). 

Além disso, todos os objetos GeneXus possuem uma guia Documentação, onde você 

também pode descrever a finalidade do objeto. 

Ao escrever a documentação, você pode incluir textos, imagens, links para atributos, 

objetos etc. Os arquivos também podem ser armazenados na Base de Conhecimento como 

parte de sua documentação. 

 

- Inteligencia artificial 

o GeneXus fornece recursos para integrar facilmente Inteligência Articial (IA). 

 

- Gerador Chatbot 

o GeneXus incluiu um gerador de Chatbot para criar e implementar automaticamente um 

chatbot em qualquer um dos provedores de Chatbot compatíveis. 

 

- Extensibilidade 

o GeneXus permite criar extensões específicas, que permitem aos desenvolvedores tirar 

proveito de diferentes linguagens de plataforma para criar soluções específicas e expandir 

os recursos principais de GeneXus. 

 

- Integração de sistemas externos e fontes de dados em um aplicativo GeneXus. 

o GeneXus ERP Connector para SAP permite o desenvolvimento de aplicativos integrados ao 

SAP ERP, o que permite complementar as funcionalidades oferecidas. 

 

- Gerenciar segurança 

GeneXus oferece um módulo de segurança (totalmente integrado em GeneXus), chamado 

GeneXus Access Manager (GAM). Ao habilitá-lo, ele oferece soluções para autenticação e 

autorização, tanto para aplicativos Web quanto para dispositivos móveis e dispositivos 

inteligentes. 

 

- Modelagem e automação dos procesos de negócio 

o GeneXus possui um conjunto de ferramentas que permitem modelar e automatizar 

processos de negócios, bem como um ambiente de execução para gerenciá-los. A 

https://wiki.genexus.com/commwiki/servlet/wiki?40167,Toc%3AGeneXus+Artificial+Intelligence,
https://wiki.genexus.com/commwiki/servlet/wiki?37102,Chatbot+generator,
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ferramenta de modelagem GeneXus Business Process Modeler é baseada no padrão BPMN 

2.0 e destina-se a usuários cujo objetivo é modelar processos de negócios. Esses diagramas 

podem ser integrados ou criados no ambiente de desenvolvimento GeneXus para 

implementar o estágio de automação, onde, através de GeneXus, associamos os diferentes 

objetos em cada tarefa modelada nos processos. O GXflow oferece as ferramentas de 

execução, administração e monitoramento para usuários finais. Desta forma, GeneXus 

oferece o que conhecemos como GeneXus BPM Suite, que é o conjunto de ferramentas que 

permite o desenvolvimento de sistemas baseados em Business Process Management, ou 

seja, sistemas orientados a processos de negócio. 

 

- Relatórios 

o Definição de relatórios estáticos (relatórios típicos que podem ser impressos, salvos ou 

exibidos na tela). 

o Definição de consultas visuais e dinâmicas. 

▪ Você pode criar consultas ao banco de dados, agrupar dados de acordo com um 

ou vários critérios, realizar cálculos e, finalmente, mostrar o resultado em 

diferentes tipos de gráficos, tabelas dinâmicas e tabelas. Para realizar este tipo de 

consulta, GeneXus oferece o objeto Query e o controle Query Viewer. 

▪ Além disso, o producto GXquery permite que os usuários finais executem consultas 

dinamicamente, com base no mesmo modelo de dados da Base de 

Conhecimento. Esta ferramenta se concentra em permitir acesso e análise de 

dados no banco de dados operacional real do sistema e fornece ao usuário uma 

interface intuitiva a partir da qual você pode criar suas próprias consultas e 

visualizá-las através da interface web e do aplicativo. móvel ou integrado ao 

Microsoft Office Excel. 

 

- Desenvolvimento compartilhado e Marketplace 

o GeneXus Marketplace permite aos desenvolvedores compartilhar seus controles de usuário, 

extensões, padrões, ferramentas externas e objetos externos criados para e com GeneXus. 

 

- Teste de aplicativos com o GXtest 

o Quando novas funcionalidades ou variações são implementadas, é necessário verificar se o 

que funcionou (antes das mudanças) continua a funcionar corretamente. Esse tipo de tarefa 

pode se tornar muito entediante se o aplicativo crescer muito, já que a quantidade de 

coisas para testar aumentará a cada vez, etc. GeneXus ajuda a automatizar esses testes 

através de seu software GXtest, que permite salvar seqüências de operações para testar. Em 

seguida, os testes são reproduzidos automaticamente, verificando se o sistema ainda está 

funcionando corretamente. 

 

https://marketplace.genexus.com/home.aspx?,en
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PRÓXIMOS PASSOS 

 

Chegou até aqui se familiarizando com GeneXus, então a pergunta natural é "Qual é o próximo 

passo?”. 

 

- Primero o primero: 

o Acesse o seguinte curso on-line para continuar aprendendo: 

http://training.genexus.com/genexus-15-course-presentation?en 

o Se você ainda não experimentou GeneXus, pode fazê-lo gratuitamente neste link: 

http://genexus.com/trial 

 

- Aprenda mais: GeneXus é uma plataforma de desenvolvimento muito completa e há muito 

para ler e aprender. Poderia começar a se aprofundar em: The GeneXus Training site: 

http://training.genexus.com/ 

o Site de treinamento de GeneXus: http://training.genexus.com/ 

o GeneXus Wiki: http://wiki.genexus.com/ 

 

¡Obtenha GeneXus! Nós nos esforçamos para fornecer a melhor ferramenta, a fim de simplificar o 

desenvolvimento de software, por isso damos as boas vindas a cada novo cliente como o primeiro. 

Entre em contato conosco através do e-mail info@genexus.com ou acesse 

http://genexus.com/plans para ver qual deles é melhor para você. 

 

- Faça parte da nossa comunidade: Quando estiver pronto, você pode se juntar à nossa 

crescente comunidade através de uma variedade de opções. 

o Publique seu trabalho em nosso mercado: http://marketplace.genexus.com/ 

o Trabalhe com GeneXus: http://genexus.com/company/work-with-us?en 

o Oportunidades oferecidas por nossos 

sócios:http://genexus.com/jobs/Opportunities?en 

o Faça parte da GeneXus Alliance: http://genexus.com/partners 

o Assista ao próximo Encontro GeneXus: http://genexus.com/meetings 

 

 

 

 

 

 

http://training.genexus.com/genexus-15-course-presentation?en
http://genexus.com/trial
http://training.genexus.com/
http://training.genexus.com/
http://wiki.genexus.com/
http://marketplace.genexus.com/
http://genexus.com/company/work-with-us?en
http://genexus.com/jobs/Opportunities?en
http://genexus.com/partners
http://genexus.com/meetings
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We really hope we hear from you soon!!! 

  


